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Vivien Release 2.0
Release Notes

August 2008
Thank you for installing Vivien Version 2.0. These release notes provide the most up-to-
date information about content and fixes made to the application.

To Help You Get Started with Vivien

To help you get started using Vivien, a number of sample files and various
documentation sources are available for your use.

Documentation sources
Documentation sources are available in several locations for your convenience:
= from the Vivien Install panel during installation
= on the Vivien Version 2.0 CD (in the \Support Documentation folder)
= from the Start>Programs>Vivien shortcut menu (once Vivien has been installed)

= from the Vivien Web site http://www.viviendesign.com/

Sources include:
= User's Guide
» Getting Started Guide
* Release Notes
Sample files

Sample Vivien files are provided with the installation for you to use as examples or
references. These files can be found in the \Samples folder where you installed Vivien
(for example, C:\Program Files\Vivien\Samples).

Vivien-Virtual Event Designer compatibility with wysiwyg

Vivien is fully compatible with CAST Software’s award-winning lighting design software
suite, wysiwyg. You can create your events in Vivien and then open the files in wysiwyg
if you want to add even more sophisticated lighting effects.

You can use Vivien—-Virtual Event Designer to increase your planning efficiency. Vivien is
the sales, planning, design, and production tool designed for the meeting and special
events industry. Once you have created your event in Vivien, you can share your file
with a Lighting Designer who can open it in wysiwyg. In this way, you can exchange
ideas and share updates to your files, taking advantage of the file compatibility between
Vivien and wysiwyg.

While Vivien deals with the venue, wysiwyg deals with the stage. However, both wysiwyg
and Vivien:

e Feature simplified CAD tools to plot or lay out floor spaces or lighting plans
e Deliver photorealistic renderings of these drawings
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Contain 1000s of library objects designed for the industry
Share the same reliable, robust base code

Deliver eye-popping visuals

Provide Wizards for common tasks

Minimum system requirements for Vivien

e Intel Pentium 4/Celeron or compatible processor

e 2.0 Ghz or better Windows XP with Service Pack 2 (or later) or Windows Vista
MAC Intel Processor platforms with Windows XP (SP2 or later) or Windows Vista
(on Bootcamp configuration or with Parallels software installed)

Note: When running Vivien on a MAC with Bootcamp, performance is
comparable to running Vivien on a PC. When running Vivien on a MAC in
Parallels, performance is slightly degraded when compared to a PC.

512MB RAM

1024MB or 1GB free disk space (NTFS file system)

1024 x 768 or better resolution

OpenGL-accelerated display adapter with 64MB video memory

Video card requirements to display Enhanced Beams

To display our new beam simulation in the Virtual Views, the video card requirements
have changed for Vivien 2.0. Our new simulation feature takes advantage of advanced
graphical technologies available only in OpenGL 2.0. As a result, your computer must
have a video card that supports OpenGL 2.0 to run the latest version of Vivien with its
enhanced features. If you do not have this type of card, a warning appears and the
Enhanced Simulation option will not be available. However, you will still be able to run
the software and visualize the beams with our original beam representation.

Hard drive compatibility

Due to restrictions in file name length, you cannot install Vivien on a FAT32-formatted
hard drive. Instead, you must install the product on an NTFS-formatted hard drive. For
details, see http://www.viviendesign.com/howto.html?tab=Installation Note.
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New in Vivien 2.0
Vivien 2.0 contains the following new features:
Drawing Wireframe Enhancements

e Ruler Tool: The new Ruler tool provides a handy point of reference, enabling
you to measure the objects that you are drawing and get an accurate idea of the
distances between items in your plot.

e Custom Gobo Wizard: This new feature enables you to import your own images
to the Gobo folder in Vivien’s library. You can then enhance the themes of your
event files by projecting these custom images (for example, corporate logos)
using Vivien’s light fixtures.

e Enhanced Uplighting Truss Wizard Feature: The Truss Wizard now enables
you to specify the direction in which all hung fixtures will face, either upward or
downward. If you specify the upward fixture direction when hanging a piece of
truss, you can easily create uplighting effects by dragging the truss just below the
floor of your venue, leaving only the lights in the venue, shining up from the floor
toward the ceiling. In addition, a new truss type called Floor Base has been
added. Light fixtures attached to this truss type always point upwards.

e Enhanced Custom Library Seating Wizard Feature: The Seating Wizard now
enables you to use any of your custom library items with the Wizard. When you
create a custom library item, if it is saved in either the Tables or Chairs section of
the library browser, they are now available in the Seating Wizard.

e Replace Fixtures: When you have designed a Vivien file that includes fixtures,
and you would like to replace the existing fixtures in the file with new ones, you
can use the new Replace Fixtures feature. Simply select the fixtures, click Edit >
Replace Fixtures (or right-click and choose this option) and, from the Fixture
Selection window that appears, select the desired new fixture. In so doing, you
will replace the existing fixture(s) in the file with the new one, and update all tabs
in the file. This feature is extremely useful when you open a Vivien file from
previous releases and would like to replace its fixtures with updated versions.

e Cone Tool: Need to draw cone-shaped set elements? You can now create cone
shapes of any size with our new Cone tool.

¢ Enhanced Drawing Options: When drawing spheres, cylinders, and circles you
now have additional choices when specifying the dimensions—you can specify
the horizontal and vertical radius.

o New Line Weight Options: When drawing lines, you can now choose from a
series of pre-defined thicknesses (line weights), and then view a realistic
representation of the line in all wireframe views in all modes. For objects like
risers and cylinders, you can change the weight of their wireframe outline after
you place them in your drawing.

e Texture Mapping Options: When you stretch a texture over an object, you can
now make sure that it will remain true to the original image by using the Texture
Aspect Ratio Stretch feature. And if the object is too big to be completely covered
by the texture, you can choose the colour that will be applied to the remaining
surface area of the object, kind of like a border that wraps around the picture.

e Support for AutoCAD 2007/2008 Import/Export: Vivien 2.0 includes import/
export support for the latest version of AutoCAD.
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Layer Tooltips: In Vivien 2.0, you no longer have to select objects to find out
which layer they're on—the layer now appears when you hover over them.

New Options for Renaming: In Vivien 2.0, you have the option of renaming all
elements of any object in your file, both custom-drawn and those inserted from
the library. When you save the file, the new element names are saved with it, so
you never have to rename them again.

Improved Custom Library Objects: In Vivien 2.0, when you create a custom
object, apply colour and texture, rename its elements, and then export it as a
custom library object, it stays exactly the same as the original, with all colours
and textures applied.

New Functionality for Custom Library Objects/Gobos: Vivien 2.0 includes a
new feature for deleting custom library objects that you are not using. Just right-
click in the Library Browser and delete the items that you no longer want to keep.
This feature also applies to custom gobos.

Extended Support for Breaking Solids into Faces: In Vivien 2.0, you can
modify Vivien'’s existing library objects by breaking them into individual
Faces/Lines that you can customize as you wish. When you break these objects
up, all of their custom Appearance Elements and Sidedness properties are
retained.

Boolean Objects, Subtract/Unite/Intersect Tools (FOR ADVANCED USERS):
In Vivien 2.0, you can use Vivien’s new “Boolean Objects” tools to cut holes into
objects, join objects, and delete everything outside of the common area of two
merged objects. A common toolset in CAD-based drawing programs like
AutoCAD, the Vivien version includes such actions as Subtracting, Uniting, and
Intersecting (the tricky operation of merging two objects and then deleting
everything outside of their common area, or intersecting point). In Vivien, you can
perform these operations in 2D or 3D.

Virtual View Enhancements

Enhanced Beams: The Virtual View looks more realistic with the enhancements
made to our light beams. This new feature adds realism to your file by
introducing a soft-edge beam with volumetric representation, beam flare at
certain angles, and beam color-mixing.

Atmospheric Smoke: This new feature introduces atmospheric smoke in the
Virtual Views. By turning this option on, you can visualize the enhanced beams
with still or animated smoke.

Texture Appearance Improvements: Texture mapping has been improved so
that all of the textures in your file are even more realistic in the Virtual View.

Library Enhancements

New Fixtures in Library: A list of eight new lighting fixtures has been added to
the Vivien library to offer more selection when designing your events. These
include some more generic lighting fixtures, such as PARs, Flood, and Fresnel
fixtures, a Mirror Ball, and a new Traditional Chandelier. Note that the Crystal
Chandelier has been removed from the Vivien library; however, you can still open
files that contain the Crystal Chandelier in Vivien 2.0.

New Library Objects: Vivien 2.0 contains many new library objects, such as
tables and chairs, people, buffet items, and more.

New Preview Images: The preview renderings of Library objects have been
enhanced with consistent and more colorful images.
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File Management Enhancements

o File Compression: In Vivien 2.0, you can use this new option to compress your
Vivien file up to ten times its original size without affecting the contents of the file.
When you select this option, Vivien files will take up less space in your
computer's memory. You will also be able to send these compressed files as
email attachments to your partners and clients with greater ease.

e Remove Imported Floor Plan: You can now remove a floor plan image that you
imported into your Vivien file by using the new Delete Floor Plan feature.

o Compatibility with wysiwyg Release 22: You can now open your Vivien files in
the latest release of wysiwyg, the industry standard lighting design software suite.

In-Place Update

The In-Place update available with Version 2.0 will update Version 1.5 of Vivien to the
latest release (Version 2.0). This update is available from our website:
http://www.viviendesign.com/howto.html?tab=Downloads.

Library Additions

The following additions were made to the library in this release:

Path

Name

Tables—>Imperial->
Dining - Round

3ft Round Dining Table, Tablecloth and Double Overlay

4ft Round Dining Table, Tablecloth and Double Overlay

5ft Round Dining Table, Tablecloth and Double Overlay

5ftéin Round Dining Table, Tablecloth and Double Overlay

6ft Round Dining Table, Tablecloth and Double Overlay

Tables>Imperial>
Dining—>Round w/
Banquet Chairs

3ft Round Dining Table w/ 4 Chairs, Tablecloth and Double
Overlay

3ft Round Dining Table w/ 6 Chairs, Tablecloth and Double
Overlay

4ft Round Dining Table w/ 4 Chairs, Tablecloth and Double
Overlay

4ft Round Dining Table w/ 6 Chairs, Tablecloth and Double
Overlay

4ft Round Dining Table w/ 8 Chairs, Tablecloth and Double
Overlay

5ft Round Dining Table w/ 4 Chairs, Tablecloth and Double
Overlay

5ft Round Dining Table w/ 6 Chairs, Tablecloth and Double
Overlay

5ft Round Dining Table w/ 8 Chairs, Tablecloth and Double
Overlay

5ft Round Dining Table w/ 10 Chairs, Tablecloth and
Double Overlay
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Path

Name

5ft6in Round Dining Table w/ 6 Chairs, Tablecloth and
Double Overlay

5ft6in Round Dining Table w/ 8 Chairs, Tablecloth and
Double Overlay

5ft6in Round Dining Table w/ 10 Chairs, Tablecloth and
Double Overlay

6ft Round Dining Table w/ 8 Chairs, Tablecloth and Double
Overlay

6ft Round Dining Table w/ 10 Chairs, Tablecloth and
Double Overlay

6ft Round Dining Table w/ 12 Chairs, Tablecloth and
Double Overlay

Tables - Imperial >
Dining = Round > w/
Banquet Chairs >
Crescent Set-Up

3ft Round Dining Table w/ 3 Chairs

3ft Round Dining Table w/ 3 Chairs and Tablecloth

3ft Round Dining Table w/ 3 Chairs, Tablecloth and Overlay

3ft Round Dining Table w/ 3 Chairs, Tablecloth and Place
Settings

4ft Round Dining Table w/ 3 Chairs

4ft Round Dining Table w/ 3 Chairs and Tablecloth

4ft Round Dining Table w/ 3 Chairs, Tablecloth and Overlay

4ft Round Dining Table w/ 3 Chairs, Tablecloth and Place
Settings

4ft Round Dining Table w/ 4 Chairs

4ft Round Dining Table w/ 4 Chairs and Tablecloth

4ft Round Dining Table w/ 4 Chairs, Tablecloth and Overlay

4ft Round Dining Table w/ 4 Chairs, Tablecloth and Place
Settings

5ft Round Dining Table w/ 3 Chairs

5ft Round Dining Table w/ 3 Chairs and Tablecloth

5ft Round Dining Table w/ 3 Chairs, Tablecloth and Overlay

5ft Round Dining Table w/ 3 Chairs, Tablecloth and Place
Settings

5ft Round Dining Table w/ 4 Chairs

5ft Round Dining Table w/ 4 Chairs and Tablecloth

5ft Round Dining Table w/ 4 Chairs, Tablecloth and Overlay

5ft Round Dining Table w/ 4 Chairs, Tablecloth and Place
Settings

5ft Round Dining Table w/ 5 Chairs

5ft Round Dining Table w/ 5 Chairs and Tablecloth

5ft Round Dining Table w/ 5 Chairs, Tablecloth and Overlay

5ft Round Dining Table w/ 5 Chairs, Tablecloth and Place
Settings

5ft6in Round Dining Table w/ 3 Chairs

5ft6in Round Dining Table w/ 3 Chairs and Tablecloth

5ft6in Round Dining Table w/ 3 Chairs, Tablecloth and
Overlay

5ft6in Round Dining Table w/ 3 Chairs, Tablecloth and
Place Settings

5ft6in Round Dining Table w/ 4 Chairs

5ft6in Round Dining Table w/ 4 Chairs and Tablecloth
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Path

Name

5ft6in Round Dining Table w/ 4 Chairs, Tablecloth and
Overlay

5ft6in Round Dining Table w/ 4 Chairs, Tablecloth and
Place Settings

5ft6in Round Dining Table w/ 5 Chairs

5ft6in Round Dining Table w/ 5 Chairs and Tablecloth

5ft6in Round Dining Table w/ 5 Chairs, Tablecloth and
Overlay

5ft6in Round Dining Table w/ 5 Chairs, Tablecloth and
Place Settings

6ft Round Dining Table w/ 4 Chairs

6ft Round Dining Table w/ 4 Chairs and Tablecloth

6ft Round Dining Table w/ 4 Chairs, Tablecloth and Overlay

6ft Round Dining Table w/ 4 Chairs, Tablecloth and Place
Settings

6ft Round Dining Table w/ 5 Chairs

6ft Round Dining Table w/ 5 Chairs and Tablecloth

6ft Round Dining Table w/ 5 Chairs, Tablecloth and Overlay

6ft Round Dining Table w/ 5 Chairs, Tablecloth and Place
Settings

6ft Round Dining Table w/ 6 Chairs

6ft Round Dining Table w/ 6 Chairs and Tablecloth

6ft Round Dining Table w/ 6 Chairs, Tablecloth and Overlay

6ft Round Dining Table w/ 6 Chairs, Tablecloth and Place
Settings

Table—>Imperial>
Dining->Round w/
Folding Chairs

3ft

3ft Round Dining Table w/ 4 Folding Chairs

3ft Round Dining Table w/ 4 Folding Chairs and Tablecloth

3ft Round Dining Table w/ 4 Folding Chairs, Tablecloth and
Double Overlay

3ft Round Dining Table w/ 4 Folding Chairs, Tablecloth and
Overlay

3ft Round Dining Table w/ 4 Folding Chairs, Tablecloth and
Place Settings

3ft Round Dining Table w/ 6 Folding Chairs

3ft Round Dining Table w/ 6 Folding Chairs and Tablecloth

3ft Round Dining Table w/ 6 Folding Chairs, Tablecloth and
Double Overlay

3ft Round Dining Table w/ 6 Folding Chairs, Tablecloth and
Overlay

3ft Round Dining Table w/ 6 Folding Chairs, Tablecloth and
Place Settings

4ft

4ft Round Dining Table w/ 4 Folding Chairs

4ft Round Dining Table w/ 4 Folding Chairs and Tablecloth

4ft Round Dining Table w/ 4 Folding Chairs, Tablecloth and
Double Overlay

4ft Round Dining Table w/ 4 Folding Chairs, Tablecloth and
Overlay

4ft Round Dining Table w/ 4 Folding Chairs, Tablecloth and

Page 7 of 42

o
\= vivien



-
- cast “eae
Vivien 2.0 Release Notes software

Path Name

Place Settings

4t Round Dining Table w/ 6 Folding Chairs

4t Round Dining Table w/ 6 Folding Chairs and Tablecloth
4ft Round Dining Table w/ 6 Folding Chairs, Tablecloth and
Double Overlay

4ft Round Dining Table w/ 6 Folding Chairs, Tablecloth and
Overlay

4ft Round Dining Table w/ 6 Folding Chairs, Tablecloth and
Place Settings

4t Round Dining Table w/ 8 Folding Chairs

4t Round Dining Table w/ 8 Folding Chairs and Tablecloth
4ft Round Dining Table w/ 8 Folding Chairs, Tablecloth and
Double Overlay

4ft Round Dining Table w/ 8 Folding Chairs, Tablecloth and
Overlay

4ft Round Dining Table w/ 8 Folding Chairs, Tablecloth and
Place Settings

5ft 5ft Round Dining Table w/ 4 Folding Chairs

5ft Round Dining Table w/ 4 Folding Chairs and Tablecloth
5ft Round Dining Table w/ 4 Folding Chairs, Tablecloth and
Double Overlay

5ft Round Dining Table w/ 4 Folding Chairs, Tablecloth and
Overlay

5ft Round Dining Table w/ 4 Folding Chairs, Tablecloth and
Place Settings

5ft Round Dining Table w/ 6 Folding Chairs

5ft Round Dining Table w/ 6 Folding Chairs and Tablecloth
5ft Round Dining Table w/ 6 Folding Chairs, Tablecloth and
Double Overlay

5ft Round Dining Table w/ 6 Folding Chairs, Tablecloth and
Overlay

5ft Round Dining Table w/ 6 Folding Chairs, Tablecloth and
Place Settings

5ft Round Dining Table w/ 8 Folding Chairs

5ft Round Dining Table w/ 8 Folding Chairs and Tablecloth
5ft Round Dining Table w/ 8 Folding Chairs, Tablecloth and
Double Overlay

5ft Round Dining Table w/ 8 Folding Chairs, Tablecloth and
Overlay

5ft Round Dining Table w/ 8 Folding Chairs, Tablecloth and
Place Settings

5ft Round Dining Table w/ 10 Folding Chairs

5ft Round Dining Table w/ 10 Folding Chairs and
Tablecloth

5ft Round Dining Table w/ 10 Folding Chairs, Tablecloth
and Double Overlay

5ft Round Dining Table w/ 10 Folding Chairs, Tablecloth
and Overlay

5ft Round Dining Table w/ 10 Folding Chairs, Tablecloth
and Place Settings
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Path Name

5ft 5ft6in Round Dining Table w/ 6 Folding Chairs
6in

5ft6in Round Dining Table w/ 6 Folding Chairs and
Tablecloth

5ft6in Round Dining Table w/ 6 Folding Chairs, Tablecloth
and Double Overlay

5ft6in Round Dining Table w/ 6 Folding Chairs, Tablecloth
and Overlay

5ft6in Round Dining Table w/ 6 Folding Chairs, Tablecloth
and Place Settings

5ft6in Round Dining Table w/ 8 Folding Chairs

5ft6in Round Dining Table w/ 8 Folding Chairs and
Tablecloth

5ft6in Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Double Overlay

5ft6in Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Overlay

5ft6in Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Place Settings

5ft6in Round Dining Table w/ 10 Folding Chairs

5ft6in Round Dining Table w/ 10 Folding Chairs and
Tablecloth

5ft6in Round Dining Table w/ 10 Folding Chairs, Tablecloth
and Double Overlay

5ft6in Round Dining Table w/ 10 Folding Chairs, Tablecloth
and Overlay

5ft6in Round Dining Table w/ 10 Folding Chairs, Tablecloth
and Place Settings

6ft 6ft Round Dining Table w/ 8 Folding Chairs

6ft Round Dining Table w/ 8 Folding Chairs and Tablecloth
6ft Round Dining Table w/ 8 Folding Chairs, Tablecloth and
Double Overlay

6ft Round Dining Table w/ 8 Folding Chairs, Tablecloth and
Overlay

6ft Round Dining Table w/ 8 Folding Chairs, Tablecloth and
Place Settings

6ft Round Dining Table w/ 10 Folding Chairs

6ft Round Dining Table w/ 10 Folding Chairs and
Tablecloth

6ft Round Dining Table w/ 10 Folding Chairs, Tablecloth
and Double Overlay

6ft Round Dining Table w/ 10 Folding Chairs, Tablecloth
and Overlay

6ft Round Dining Table w/ 10 Folding Chairs, Tablecloth
and Place Settings

6ft Round Dining Table w/ 12 Folding Chairs

6ft Round Dining Table w/ 12 Folding Chairs and
Tablecloth

6ft Round Dining Table w/ 12 Folding Chairs, Tablecloth
and Double Overlay
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Path Name

6ft Round Dining Table w/ 12 Folding Chairs, Tablecloth
and Overlay

6ft Round Dining Table w/ 12 Folding Chairs, Tablecloth
and Place Settings

Tables>Imperial> Folding Table 3ft Round, Tablecloth and Double Overlay
Dining > Round Folding

Folding Table 4ft Round, Tablecloth and Double Overlay
Folding Table 5ft Round, Tablecloth and Double Overlay
Folding Table 5ft6in Round, Tablecloth and Double Overlay
Folding Table 6ft Round, Tablecloth and Double Overlay

Tables—>Imperial> Folding Table 3ft Round w/ 4 Chairs, Tablecloth and
Dining—> Round Folding Double Overlay
w/ Banquet Chairs

Folding Table 3ft Round w/ 6 Chairs, Tablecloth and
Double Overlay

Folding Table 4ft Round w/ 4 Chairs, Tablecloth and
Double Overlay

Folding Table 4ft Round w/ 6 Chairs, Tablecloth and
Double Overlay

Folding Table 4ft Round w/ 8 Chairs, Tablecloth and
Double Overlay

Folding Table 5ft Round w/ 4 Chairs, Tablecloth and
Double Overlay

Folding Table 5ft Round w/ 6 Chairs, Tablecloth and
Double Overlay

Folding Table 5ft Round w/ 8 Chairs, Tablecloth and
Double Overlay

Folding Table 5ft Round w/ 10 Chairs, Tablecloth and
Double Overlay

Folding Table 5ft6in Round w/ 6 Chairs, Tablecloth and
Double Overlay

Folding Table 5ft6in Round w/ 8 Chairs, Tablecloth and
Double Overlay

Folding Table 5ft6in Round w/ 10 Chairs, Tablecloth and
Double Overlay

Folding Table 6ft Round w/ 8 Chairs, Tablecloth and
Double Overlay

Folding Table 6ft Round w/ 10 Chairs, Tablecloth and
Double Overlay

Folding Table 6ft Round w/ 12 Chairs, Tablecloth and
Double Overlay

Table—>Imperial> Folding Table 3ft Round w/ 4 Folding Chairs
Dining—>Round 3ft
Folding w/ Folding
Chairs

Folding Table 3ft Round w/ 4 Folding Chairs and Tablecloth
Folding Table 3ft Round w/ 4 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 3ft Round w/ 4 Folding Chairs, Tablecloth
and Overlay
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Path

Name

Folding Table 3ft Round w/ 4 Folding Chairs, Tablecloth
and Place Settings

Folding Table 3ft Round w/ 6 Folding Chairs

Folding Table 3ft Round w/ 6 Folding Chairs and Tablecloth

Folding Table 3ft Round w/ 6 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 3ft Round w/ 6 Folding Chairs, Tablecloth
and Overlay

Folding Table 3ft Round w/ 6 Folding Chairs, Tablecloth
and Place Settings

4ft

Folding Table 4ft Round w/ 4 Folding Chairs

Folding Table 4ft Round w/ 4 Folding Chairs and Tablecloth

Folding Table 4ft Round w/ 4 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 4ft Round w/ 4 Folding Chairs, Tablecloth
and Overlay

Folding Table 4ft Round w/ 4 Folding Chairs, Tablecloth
and Place Settings

Folding Table 4ft Round w/ 6 Folding Chairs

Folding Table 4ft Round w/ 6 Folding Chairs and Tablecloth

Folding Table 4ft Round w/ 6 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 4ft Round w/ 6 Folding Chairs, Tablecloth
and Overlay

Folding Table 4ft Round w/ 6 Folding Chairs, Tablecloth
and Place Settings

Folding Table 4ft Round w/ 8 Folding Chairs

Folding Table 4ft Round w/ 8 Folding Chairs and Tablecloth

Folding Table 4ft Round w/ 8 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 4ft Round w/ 8 Folding Chairs, Tablecloth
and Overlay

Folding Table 4ft Round w/ 8 Folding Chairs, Tablecloth
and Place Settings

5ft

Folding Table 5ft Round w/ 4 Folding Chairs

Folding Table 5ft Round w/ 4 Folding Chairs and Tablecloth

Folding Table 5ft Round w/ 4 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 5ft Round w/ 4 Folding Chairs, Tablecloth
and Overlay

Folding Table 5ft Round w/ 4 Folding Chairs, Tablecloth
and Place Settings

Folding Table 5ft Round w/ 6 Folding Chairs

Folding Table 5ft Round w/ 6 Folding Chairs and Tablecloth

Folding Table 5ft Round w/ 6 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 5ft Round w/ 6 Folding Chairs, Tablecloth
and Overlay

Folding Table 5ft Round w/ 6 Folding Chairs, Tablecloth
and Place Settings
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Path

Name

Folding Table 5ft Round w/ 8 Folding Chairs

Folding Table 5ft Round w/ 8 Folding Chairs and Tablecloth

Folding Table 5ft Round w/ 8 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 5ft Round w/ 8 Folding Chairs, Tablecloth
and Overlay

Folding Table 5ft Round w/ 8 Folding Chairs, Tablecloth
and Place Settings

Folding Table 5ft Round w/ 10 Folding Chairs

Folding Table 5ft Round w/ 10 Folding Chairs and
Tablecloth

Folding Table 5ft Round w/ 10 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 5ft Round w/ 10 Folding Chairs, Tablecloth
and Overlay

Folding Table 5ft Round w/ 10 Folding Chairs, Tablecloth
and Place Settings

5ft
6in

Folding Table 5ft6in Round w/ 6 Folding Chairs

Folding Table 5ft6in Round w/ 6 Folding Chairs and
Tablecloth

Folding Table 5ft6in Round w/ 6 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 5ft6in Round w/ 6 Folding Chairs, Tablecloth
and Overlay

Folding Table 5ft6in Round w/ 6 Folding Chairs, Tablecloth
and Place Settings

Folding Table 5ft6in Round w/ 8 Folding Chairs

Folding Table 5ft6in Round w/ 8 Folding Chairs and
Tablecloth

Folding Table 5ft6in Round w/ 8 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 5ft6in Round w/ 8 Folding Chairs, Tablecloth
and Overlay

Folding Table 5ft6in Round w/ 8 Folding Chairs, Tablecloth
and Place Settings

Folding Table 5ft6in Round w/ 10 Folding Chairs

Folding Table 5ft6in Round w/ 10 Folding Chairs and
Tablecloth

Folding Table 5ft6in Round w/ 10 Folding Chairs,
Tablecloth and Double Overlay

Folding Table 5ft6in Round w/ 10 Folding Chairs,
Tablecloth and Overlay

Folding Table 5ft6in Round w/ 10 Folding Chairs,
Tablecloth and Place Settings

6ft

Folding Table 6ft Round w/ 8 Folding Chairs

Folding Table 6ft Round w/ 8 Folding Chairs and Tablecloth

Folding Table 6ft Round w/ 8 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 6ft Round w/ 8 Folding Chairs, Tablecloth
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Path

Name

and Overlay

Folding Table 6ft Round w/ 8 Folding Chairs, Tablecloth
and Place Settings

Folding Table 6ft Round w/ 10 Folding Chairs

Folding Table 6ft Round w/ 10 Folding Chairs and
Tablecloth

Folding Table 6ft Round w/ 10 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 6ft Round w/ 10 Folding Chairs, Tablecloth
and Overlay

Folding Table 6ft Round w/ 10 Folding Chairs, Tablecloth
and Place Settings

Folding Table 6ft Round w/ 12 Folding Chairs

Folding Table 6ft Round w/ 12 Folding Chairs and
Tablecloth

Folding Table 6ft Round w/ 12 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 6ft Round w/ 10 Folding Chairs, Tablecloth
and Overlay

Folding Table 6ft Round w/ 10 Folding Chairs, Tablecloth
and Place Settings

Tables—>Metric>Dining
- Round

90cm Round Dining Table, Tablecloth and Double Overlay

120cm Round Dining Table, Tablecloth and Double Overlay

150cm Round Dining Table, Tablecloth and Double Overlay

168cm Round Dining Table, Tablecloth and Double
Overlay

180cm Round Dining Table, Tablecloth and Double Overlay

Tables>Metric>Dining
—~>Round w/ Banquet
Chairs

90cm Round Dining Table w/ 4 Chairs, Tablecloth and
Double Overlay

90cm Round Dining Table w/ 6 Chairs, Tablecloth and
Double Overlay

120cm Round Dining Table w/ 4 Chairs, Tablecloth and
Double Overlay

120cm Round Dining Table w/ 6 Chairs, Tablecloth and
Double Overlay

120cm Round Dining Table w/ 8 Chairs, Tablecloth and
Double Overlay

150cm Round Dining Table w/ 4 Chairs, Tablecloth and
Double Overlay

150cm Round Dining Table w/ 6 Chairs, Tablecloth and
Double Overlay

150cm Round Dining Table w/ 8 Chairs, Tablecloth and
Double Overlay

150cm Round Dining Table w/ 10 Chairs, Tablecloth and
Double Overlay

168cm Round Dining Table w/ 6 Chairs, Tablecloth and
Double Overlay

168cm Round Dining Table w/ 8 Chairs, Tablecloth and
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Double Overlay

168cm Round Dining Table w/ 10 Chairs, Tablecloth and
Double Overlay

180cm Round Dining Table w/ 8 Chairs, Tablecloth and
Double Overlay

180cm Round Dining Table w/ 10 Chairs, Tablecloth and
Double Overlay

180cm Round Dining Table w/ 12 Chairs, Tablecloth and
Double Overlay

Tables>Metric > 90cm Round Dining Table w/ 3 Chairs
Dining->Round w/
Banquet Chairs

—>Crescent Set-Up

90cm Round Dining Table w/ 3 Chairs and Tablecloth
90cm Round Dining Table w/ 3 Chairs, Tablecloth and
Overlay

90cm Round Dining Table w/ 3 Chairs, Tablecloth and
Place Settings

120cm Round Dining Table w/ 3 Chairs

120cm Round Dining Table w/ 3 Chairs and Tablecloth
120cm Round Dining Table w/ 3 Chairs, Tablecloth and
Overlay

120cm Round Dining Table w/ 3 Chairs, Tablecloth and
Place Settings

120cm Round Dining Table w/ 4 Chairs

120cm Round Dining Table w/ 4 Chairs and Tablecloth
120cm Round Dining Table w/ 4 Chairs, Tablecloth and
Overlay

120cm Round Dining Table w/ 4 Chairs, Tablecloth and
Place Settings

150cm Round Dining Table w/ 3 Chairs

150cm Round Dining Table w/ 3 Chairs and Tablecloth
150cm Round Dining Table w/ 3 Chairs, Tablecloth and
Overlay

150cm Round Dining Table w/ 3 Chairs, Tablecloth and
Place Settings

150cm Round Dining Table w/ 4 Chairs

150cm Round Dining Table w/ 4 Chairs and Tablecloth
150cm Round Dining Table w/ 4 Chairs, Tablecloth and
Overlay

150cm Round Dining Table w/ 4 Chairs, Tablecloth and
Place Settings

150cm Round Dining Table w/ 5 Chairs

150cm Round Dining Table w/ 5 Chairs and Tablecloth
150cm Round Dining Table w/ 5 Chairs, Tablecloth and
Overlay

150cm Round Dining Table w/ 5 Chairs, Tablecloth and
Place Settings

168cm Round Dining Table w/ 3 Chairs

168cm Round Dining Table w/ 3 Chairs and Tablecloth
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168cm Round Dining Table w/ 3 Chairs, Tablecloth and
Overlay

168cm Round Dining Table w/ 3 Chairs, Tablecloth and
Place Settings

168cm Round Dining Table w/ 4 Chairs

168cm Round Dining Table w/ 4 Chairs and Tablecloth
168cm Round Dining Table w/ 4 Chairs, Tablecloth and
Overlay

168cm Round Dining Table w/ 4 Chairs, Tablecloth and
Place Settings

168cm Round Dining Table w/ 5 Chairs

168cm Round Dining Table w/ 5 Chairs and Tablecloth
168cm Round Dining Table w/ 5 Chairs, Tablecloth and
Overlay

168cm Round Dining Table w/ 5 Chairs, Tablecloth and
Place Settings

180cm Round Dining Table w/ 4 Chairs

180cm Round Dining Table w/ 4 Chairs and Tablecloth
180cm Round Dining Table w/ 4 Chairs, Tablecloth and
Overlay

180cm Round Dining Table w/ 4 Chairs, Tablecloth and
Place Settings

180cm Round Dining Table w/ 5 Chairs

180cm Round Dining Table w/ 5 Chairs and Tablecloth
180cm Round Dining Table w/ 5 Chairs, Tablecloth and
Overlay

180cm Round Dining Table w/ 5 Chairs, Tablecloth and
Place Settings

180cm Round Dining Table w/ 6 Chairs

180cm Round Dining Table w/ 6 Chairs and Tablecloth
180cm Round Dining Table w/ 6 Chairs, Tablecloth and
Overlay

180cm Round Dining Table w/ 6 Chairs, Tablecloth and
Place Settings

Table->Metric> 90 90cm Round Dining Table w/ 4 Folding Chairs
Dining>Round w/ | cm
Folding Chairs

90cm Round Dining Table w/ 4 Folding Chairs and
Tablecloth

90cm Round Dining Table w/ 4 Folding Chairs, Tablecloth
and Double Overlay

90cm Round Dining Table w/ 4 Folding Chairs, Tablecloth
and Overlay

90cm Round Dining Table w/ 4 Folding Chairs, Tablecloth
and Place Setting

90cm Round Dining Table w/ 6 Folding Chairs

90cm Round Dining Table w/ 6 Folding Chairs and
Tablecloth

90cm Round Dining Table w/ 6 Folding Chairs, Tablecloth
and Double Overlay
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90cm Round Dining Table w/ 6 Folding Chairs, Tablecloth
and Overlay

90cm Round Dining Table w/ 6 Folding Chairs, Tablecloth
and Place Settings

120 | 120cm Round Dining Table w/ 4 Folding Chairs

cm

120cm Round Dining Table w/ 4 Folding Chairs and
Tablecloth

120cm Round Dining Table w/ 4 Folding Chairs, Tablecloth
and Double Overlay

120cm Round Dining Table w/ 4 Folding Chairs, Tablecloth
and Overlay

120cm Round Dining Table w/ 4 Folding Chairs, Tablecloth
and Place Settings

120cm Round Dining Table w/ 6 Folding Chairs

120cm Round Dining Table w/ 6 Folding Chairs and
Tablecloth

120cm Round Dining Table w/ 6 Folding Chairs, Tablecloth
and Double Overlay

120cm Round Dining Table w/ 6 Folding Chairs, Tablecloth
and Overlay

120cm Round Dining Table w/ 6 Folding Chairs, Tablecloth
and Place Settings

120cm Round Dining Table w/ 8 Folding Chairs

120cm Round Dining Table w/ 8 Folding Chairs and
Tablecloth

120cm Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Double Overlay

120cm Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Overlay

120cm Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Place Settings

150 | 150cm Round Dining Table w/ 4 Folding Chairs

cm

150cm Round Dining Table w/ 4 Folding Chairs and
Tablecloth

150cm Round Dining Table w/ 4 Folding Chairs, Tablecloth
and Double Overlay

150cm Round Dining Table w/ 4 Folding Chairs, Tablecloth
and Overlay

150cm Round Dining Table w/ 4 Folding Chairs, Tablecloth
and Place Settings

150cm Round Dining Table w/ 6 Folding Chairs

150cm Round Dining Table w/ 6 Folding Chairs and
Tablecloth

150cm Round Dining Table w/ 6 Folding Chairs, Tablecloth
and Double Overlay

150cm Round Dining Table w/ 6 Folding Chairs, Tablecloth
and Overlay

150cm Round Dining Table w/ 6 Folding Chairs, Tablecloth
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and Place Settings

150cm Round Dining Table w/ 8 Folding Chairs

150cm Round Dining Table w/ 8 Folding Chairs and
Tablecloth

150cm Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Double Overlay

150cm Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Overlay

150cm Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Place Settings

150cm Round Dining Table w/ 10 Folding Chairs

150cm Round Dining Table w/ 10 Folding Chairs and
Tablecloth

150cm Round Dining Table w/ 10 Folding Chairs,
Tablecloth and Double Overlay

150cm Round Dining Table w/ 10 Folding Chairs,
Tablecloth and Overlay

150cm Round Dining Table w/ 10 Folding Chairs,
Tablecloth and Place Settings

168 | 168cm Round Dining Table w/ 6 Folding Chairs

cm

168cm Round Dining Table w/ 6 Folding Chairs and
Tablecloth

168cm Round Dining Table w/ 6 Folding Chairs, Tablecloth
and Double Overlay

168cm Round Dining Table w/ 6 Folding Chairs, Tablecloth
and Overlay

168cm Round Dining Table w/ 6 Folding Chairs, Tablecloth
and Place Settings

168cm Round Dining Table w/ 8 Folding Chairs

168cm Round Dining Table w/ 8 Folding Chairs and
Tablecloth

168cm Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Double Overlay

168cm Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Overlay

168cm Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Place Settings

168cm Round Dining Table w/ 10 Folding Chairs

168cm Round Dining Table w/ 10 Folding Chairs and
Tablecloth

168cm Round Dining Table w/ 10 Folding Chairs,
Tablecloth and Double Overlay

168cm Round Dining Table w/ 10 Folding Chairs,
Tablecloth and Overlay

168cm Round Dining Table w/ 10 Folding Chairs,
Tablecloth and Place Settings

180 | 180cm Round Dining Table w/ 8 Folding Chairs
cm

180cm Round Dining Table w/ 8 Folding Chairs and
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Tablecloth

180cm Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Double Overlay

180cm Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Overlay

180cm Round Dining Table w/ 8 Folding Chairs, Tablecloth
and Place Settings

180cm Round Dining Table w/ 10 Folding Chairs

180cm Round Dining Table w/ 10 Folding Chairs and
Tablecloth

180cm Round Dining Table w/ 10 Folding Chairs,
Tablecloth and Double Overlay

180cm Round Dining Table w/ 10 Folding Chairs,
Tablecloth and Overlay

180cm Round Dining Table w/ 10 Folding Chairs,
Tablecloth and Place Settings

180cm Round Dining Table w/ 12 Folding Chairs

180cm Round Dining Table w/ 12 Folding Chairs and
Tablecloth

180cm Round Dining Table w/ 12 Folding Chairs,
Tablecloth and Double Overlay

180cm Round Dining Table w/ 12 Folding Chairs,
Tablecloth and Overlay

180cm Round Dining Table w/ 12 Folding Chairs,
Tablecloth and Place Settings

Tables->Metric>Dining
- Round Folding

Folding Table 90cm Round, Tablecloth and Double Overlay

Folding Table 120cm Round, Tablecloth and Double
Overlay

Folding Table 150cm Round, Tablecloth and Double
Overlay

Folding Table 168cm Round, Tablecloth and Double
Overlay

Folding Table 180cm Round, Tablecloth and Double
Overlay

Tables—>Metric>Dining
- Round Folding w/
Banquet Chairs

Folding Table 90cm Round w/ 4 Chairs, Tablecloth and
Double Overlay

Folding Table 90cm Round w/ 6 Chairs, Tablecloth and
Double Overlay

Folding Table 120cm Round w/ 4 Chairs, Tablecloth and
Double Overlay

Folding Table 120cm Round w/ 6 Chairs, Tablecloth and
Double Overlay

Folding Table 120cm Round w/ 8 Chairs, Tablecloth and
Double Overlay

Folding Table 150cm Round w/ 4 Chairs, Tablecloth and
Double Overlay

Folding Table 150cm Round w/ 6 Chairs, Tablecloth and
Double Overlay
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Folding Table 150cm Round w/ 8 Chairs, Tablecloth and
Double Overlay

Folding Table 150cm Round w/ 10 Chairs, Tablecloth and
Double Overlay

Folding Table 168cm Round w/ 6 Chairs, Tablecloth and
Double Overlay

Folding Table 168cm Round w/ 8 Chairs, Tablecloth and
Double Overlay

Folding Table 168cm Round w/ 10 Chairs, Tablecloth and
Double Overlay

Folding Table 6ft Round w/ 8 Chairs, Tablecloth and
Double Overlay

Folding Table 6ft Round w/ 10 Chairs, Tablecloth and
Double Overlay

Folding Table 6ft Round w/ 12 Chairs, Tablecloth and
Double Overlay

Tables - Metric >
Dining > Round Folding
w/ Banquet Chairs -
Crescent Set-Up

Round Folding w/ Banquet Chairs—> Crescent Set-Up
Folding Table 90cm Round w/ 3 Chairs, Tablecloth and
Place Settings

Folding Table 120cm Round w/ 3 Chairs

Folding Table 120cm Round w/ 3 Chairs and Tablecloth
Folding Table 120cm Round w/ 3 Chairs, Tablecloth and
Overlay

Folding Table 120cm Round w/ 3 Chairs, Tablecloth and
Place Settings

Folding Table 120cm Round w/ 4 Chairs

Folding Table 120cm Round w/ 4 Chairs and Tablecloth
Folding Table 120cm Round w/ 4 Chairs, Tablecloth and
Overlay

Folding Table 120cm Round w/ 4 Chairs, Tablecloth and
Place Settings

Folding Table 150cm Round w/ 3 Chairs

Folding Table 150cm Round w/ 3 Chairs and Tablecloth
Folding Table 150cm Round w/ 3 Chairs, Tablecloth and
Overlay

Folding Table 150cm Round w/ 3 Chairs, Tablecloth and
Place Settings

Folding Table 150cm Round w/ 4 Chairs

Folding Table 150cm Round w/ 4 Chairs and Tablecloth
Folding Table 150cm Round w/ 4 Chairs, Tablecloth and
Overlay

Folding Table 150cm Round w/ 4 Chairs, Tablecloth and
Place Settings

Folding Table 150cm Round w/ 5 Chairs

Folding Table 150cm Round w/ 5 Chairs and Tablecloth
Folding Table 150cm Round w/ 5 Chairs, Tablecloth and
Overlay

Folding Table 150cm Round w/ 5 Chairs, Tablecloth and
Place Settings
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Folding Table 168cm Round w/ 3 Chairs

Folding Table 168cm Round w/ 3 Chairs and Tablecloth
Folding Table 168cm Round w/ 3 Chairs, Tablecloth and
Overlay

Folding Table 168cm Round w/ 3 Chairs, Tablecloth and
Place Settings

Folding Table 168cm Round w/ 4 Chairs

Folding Table 168cm Round w/ 4 Chairs and Tablecloth
Folding Table 168cm Round w/ 4 Chairs, Tablecloth and
Overlay

Folding Table 168cm Round w/ 4 Chairs, Tablecloth and
Place Settings

Folding Table 168cm Round w/ 5 Chairs

Folding Table 168cm Round w/ 5 Chairs and Tablecloth
Folding Table 168cm Round w/ 5 Chairs, Tablecloth and
Overlay

Folding Table 168cm Round w/ 5 Chairs, Tablecloth and
Place Settings

Folding Table 180cm Round w/ 4 Chairs

Folding Table 180cm Round w/ 4 Chairs and Tablecloth
Folding Table 180cm Round w/ 4 Chairs, Tablecloth and
Overlay

Folding Table 180cm Round w/ 4 Chairs, Tablecloth and
Place Settings

Folding Table 180cm Round w/ 5 Chairs

Folding Table 180cm Round w/ 5 Chairs and Tablecloth
Folding Table 180cm Round w/ 5 Chairs, Tablecloth and
Overlay

Folding Table 180cm Round w/ 5 Chairs, Tablecloth and
Place Settings

Folding Table 180cm Round w/ 6 Chairs

Folding Table 180cm Round w/ 6 Chairs and Tablecloth
Folding Table 180cm Round w/ 6 Chairs, Tablecloth and
Overlay

Folding Table 180cm Round w/ 6 Chairs, Tablecloth and
Place Settings

Tables—>Imperial > Folding Table 3ft Round w/ 3 Chairs
Dining~>Round
Folding w/ Banquet
Chairs > Crescent Set-
Up

Folding Table 3ft Round w/ 3 Chairs and Tablecloth
Folding Table 3ft Round w/ 3 Chairs, Tablecloth and
Overlay

Folding Table 3ft Round w/ 3 Chairs, Tablecloth and Place
Settings

Folding Table 4ft Round w/ 3 Chairs

Folding Table 4ft Round w/ 3 Chairs and Tablecloth
Folding Table 4ft Round w/ 3 Chairs, Tablecloth and
Overlay

Page 20 of 42 s
\= vivien



-
- cast “eae
Vivien 2.0 Release Notes software

Path Name

Folding Table 4ft Round w/ 3 Chairs, Tablecloth and Place
Settings

Folding Table 4ft Round w/ 4 Chairs

Folding Table 4ft Round w/ 4 Chairs and Tablecloth
Folding Table 4ft Round w/ 4 Chairs, Tablecloth and
Overlay

Folding Table 4ft Round w/ 4 Chairs, Tablecloth and Place
Settings

Folding Table 5ft Round w/ 3 Chairs

Folding Table 5ft Round w/ 3 Chairs and Tablecloth
Folding Table 5ft Round w/ 3 Chairs, Tablecloth and
Overlay

Folding Table 5ft Round w/ 3 Chairs, Tablecloth and Place
Settings

Folding Table 5ft Round w/ 4 Chairs

Folding Table 5ft Round w/ 4 Chairs and Tablecloth
Folding Table 5ft Round w/ 4 Chairs, Tablecloth and
Overlay

Folding Table 5ft Round w/ 4 Chairs, Tablecloth and Place
Settings

Folding Table 5ft Round w/ 5 Chairs

Folding Table 5ft Round w/ 5 Chairs and Tablecloth
Folding Table 5ft Round w/ 5 Chairs, Tablecloth and
Overlay

Folding Table 5ft Round w/ 5 Chairs, Tablecloth and Place
Settings

Folding Table 5ft6in Round w/ 3 Chairs

Folding Table 5ft6in Round w/ 3 Chairs and Tablecloth
Folding Table 5ft6in Round w/ 3 Chairs, Tablecloth and
Overlay

Folding Table 5ft6in Round w/ 3 Chairs, Tablecloth and
Place Settings

Folding Table 5ft6in Round w/ 4 Chairs

Folding Table 5ftéin Round w/ 4 Chairs and Tablecloth
Folding Table 5ft6in Round w/ 4 Chairs, Tablecloth and
Overlay

Folding Table 5ft6in Round w/ 4 Chairs, Tablecloth and
Place Settings

Folding Table 5ft6in Round w/ 5 Chairs

Folding Table 5ft6in Round w/ 5 Chairs and Tablecloth
Folding Table 5ft6in Round w/ 5 Chairs, Tablecloth and
Overlay

Folding Table 5ft6in Round w/ 5 Chairs, Tablecloth and
Place Settings

Folding Table 6ft Round w/ 4 Chairs

Folding Table 6ft Round w/ 4 Chairs and Tablecloth
Folding Table 6ft Round w/ 4 Chairs, Tablecloth and
Overlay

Folding Table 6ft Round w/ 4 Chairs, Tablecloth and Place
Settings
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Folding Table 6ft Round w/ 5 Chairs

Folding Table 6ft Round w/ 5 Chairs and Tablecloth
Folding Table 6ft Round w/ 5 Chairs, Tablecloth and
Overlay

Folding Table 6ft Round w/ 5 Chairs, Tablecloth and Place
Settings

Folding Table 6ft Round w/ 6 Chairs

Folding Table 6ft Round w/ 6 Chairs and Tablecloth
Folding Table 6ft Round w/ 6 Chairs, Tablecloth and

Overlay
Folding Table 6ft Round w/ 6 Chairs, Tablecloth and Place
Settings

Tables>Metric > Folding Table 90cm Round w/ 3 Chairs

Dining->Round

Folding>w/ Chairs

Crescent Set-Up

Folding Table 90cm Round w/ 3 Chairs and Tablecloth
Folding Table 90cm Round w/ 3 Chairs, Tablecloth and
Overlay

Folding Table 90cm Round w/ 3 Chairs, Tablecloth and
Place Settings

Folding Table 120cm Round w/ 3 Chairs

Folding Table 120cm Round w/ 3 Chairs and Tablecloth
Folding Table 120cm Round w/ 3 Chairs, Tablecloth and
Overlay

Folding Table 120cm Round w/ 3 Chairs, Tablecloth and
Place Settings

Folding Table 120cm Round w/ 4 Chairs

Folding Table 120cm Round w/ 4 Chairs and Tablecloth
Folding Table 120cm Round w/ 4 Chairs, Tablecloth and
Overlay

Folding Table 120cm Round w/ 4 Chairs, Tablecloth and
Place Settings

Folding Table 150cm Round w/ 3 Chairs

Folding Table 150cm Round w/ 3 Chairs and Tablecloth
Folding Table 150cm Round w/ 3 Chairs, Tablecloth and
Overlay

Folding Table 150cm Round w/ 3 Chairs, Tablecloth and
Place Settings

Folding Table 150cm Round w/ 4 Chairs

Folding Table 150cm Round w/ 4 Chairs and Tablecloth
Folding Table 150cm Round w/ 4 Chairs, Tablecloth and
Overlay

Folding Table 150cm Round w/ 4 Chairs, Tablecloth and
Place Settings

Folding Table 150cm Round w/ 5 Chairs

Folding Table 150cm Round w/ 5 Chairs and Tablecloth
Folding Table 150cm Round w/ 5 Chairs, Tablecloth and
Overlay

Folding Table 150cm Round w/ 5 Chairs, Tablecloth and
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Place Settings

Folding Table 168cm Round w/ 3 Chairs

Folding Table 168cm Round w/ 3 Chairs and Tablecloth

Folding Table 168cm Round w/ 3 Chairs, Tablecloth and
Overlay

Folding Table 168cm Round w/ 3 Chairs, Tablecloth and
Place Settings

Folding Table 168cm Round w/ 4 Chairs

Folding Table 168cm Round w/ 4 Chairs and Tablecloth

Folding Table 168cm Round w/ 4 Chairs, Tablecloth and
Overlay

Folding Table 168cm Round w/ 4 Chairs, Tablecloth and
Place Settings

Folding Table 168cm Round w/ 5 Chairs

Folding Table 168cm Round w/ 5 Chairs and Tablecloth

Folding Table 168cm Round w/ 5 Chairs, Tablecloth and
Overlay

Folding Table 168cm Round w/ 5 Chairs, Tablecloth and
Place Settings

Folding Table 180cm Round w/ 4 Chairs

Folding Table 180cm Round w/ 4 Chairs and Tablecloth

Folding Table 180cm Round w/ 4 Chairs, Tablecloth and
Overlay

Folding Table 180cm Round w/ 4 Chairs, Tablecloth and
Place Settings

Folding Table 180cm Round w/ 5 Chairs

Folding Table 180cm Round w/ 5 Chairs and Tablecloth

Folding Table 180cm Round w/ 5 Chairs, Tablecloth and
Overlay

Folding Table 180cm Round w/ 5 Chairs, Tablecloth and
Place Settings

Folding Table 180cm Round w/ 6 Chairs

Folding Table 180cm Round w/ 6 Chairs and Tablecloth

Folding Table 180cm Round w/ 6 Chairs, Tablecloth and
Overlay

Folding Table 180cm Round w/ 6 Chairs, Tablecloth and
Place Settings

Tables—>Imperial >
Dining—> Square

4ft x 4ft Square Dining Table

4ft x 4ft Square Dining Table and Tablecloth

4ft x 4ft Square Dining Table, Tablecloth and Overlay

5ft6in x 5ft6in Square Dining Table

5ft6in x 5ft6in Square Dining Table and Tablecloth

5ft6in x 5ft6in Square Dining Table, Tablecloth and Overlay

5ft x 5ft Square Dining Table

5ft x 5ft Square Dining Table and Tablecloth

5ft x 5ft Square Dining Table, Tablecloth and Overlay

6ft x 6ft Square Dining Table

6ft x 6ft Square Dining Table and Tablecloth

6ft x 6ft Square Dining Table, Tablecloth and Overlay
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6ft x 5ft Square Dining Table

6ft x 5ft Square Dining Table and Tablecloth

6ft x 5ft Square Dining Table, Tablecloth and Overlay
8ft x 5ft Square Dining Table

8ft x 5ft Square Dining Table and Tablecloth

8ft x 5ft Square Dining Table, Tablecloth and Overlay

Tables>Imperial > 4ft x 4ft Square Dining Table w/ 4 Chairs
Dining—>Square>w/
Chairs

4ft x 4ft Square Dining Table w/ 4 Chairs and Tablecloth
4ft x 4ft Square Dining Table w/ 4 Chairs, Tablecloth and
Overlay

4ft x 4ft Square Dining Table w/ 4 Chairs, Tablecloth and
Place Settings

5ft x 5ft Square Dining Table w/ 6 Chairs

5ft x 5ft Square Dining Table w/ 6 Chairs and Tablecloth
5ft x 5ft Square Dining Table w/ 6 Chairs, Tablecloth and
Overlay

5ft x 5ft Square Dining Table w/ 6 Chairs, Tablecloth and
Place Settings

5ft6in x 5ft6in Square Dining Table w/ 8 Chairs

5ft6in x 5ft6in Square Dining Table w/ 8 Chairs and
Tablecloth

5ft6in x 5ft6in Square Dining Table w/ 8 Chairs, Tablecloth
and Overlay

5ft6in x 5ft6in Square Dining Table w/ 8 Chairs, Tablecloth
and Place Settings

6ft x 6ft Square Dining Table w/ 8 Chairs 1

6ft x 6ft Square Dining Table w/ 8 Chairs and Tablecloth 1
6ft x 6ft Square Dining Table w/ 8 Chairs, Tablecloth and
Overlay 1

6ft x 6ft Square Dining Table w/ 8 Chairs, Tablecloth and
Place Settings 1

6ft x 6ft Square Dining Table w/ 8 Chairs 2

6ft x 6ft Square Dining Table w/ 8 Chairs and Tablecloth 2
6ft x 6ft Square Dining Table w/ 8 Chairs, Tablecloth and
Overlay 2

6ft x 6ft Square Dining Table w/ 8 Chairs, Tablecloth and
Place Settings 2

6ft x 5ft Square Dining Table w/ 8 Chairs

6ft x 5ft Square Dining Table w/ 8 Chairs and Tablecloth
6ft x 5ft Square Dining Table w/ 8 Chairs, Tablecloth and
Overlay

6ft x 5ft Square Dining Table w/ 8 Chairs, Tablecloth and
Place Settings

8ft x 5ft Square Dining Table w/ 8 Chairs

8ft x 5ft Square Dining Table w/ 8 Chairs and Tablecloth
8ft x 5ft Square Dining Table w/ 8 Chairs, Tablecloth and
Overlay

8ft x 5ft Square Dining Table w/ 8 Chairs, Tablecloth and
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Place Settings

8ft x 5ft Square Dining Table w/ 10 Chairs

8ft x 5ft Square Dining Table w/ 10 Chairs and Tablecloth
8ft x 5ft Square Dining Table w/ 10 Chairs, Tablecloth and
Overlay

8ft x 5ft Square Dining Table w/ 10 Chairs, Tablecloth and
Place Settings

Tables—>Metric > 120cm x 120cm Square Dining Table
Dining—> Square

120cm x 120cm Square Dining Table and Tablecloth
120cm x 120cm Square Dining Table, Tablecloth and
Overlay

168cm x 168cm Square Dining Table

168cm x 168cm Square Dining Table and Tablecloth
168cm x 168cm Square Dining Table, Tablecloth and
Overlay

150cm x 150cm Square Dining Table

150cm x 150cm Square Dining Table and Tablecloth
150cm x 150cm Square Dining Table, Tablecloth and
Overlay

180cm x 180cm Square Dining Table

180cm x 180cm Square Dining Table and Tablecloth
180cm x 180cm Square Dining Table, Tablecloth and
Overlay

180cm x 150cm Square Dining Table

180cm x 150cm Square Dining Table and Tablecloth
180cm x 150cm Square Dining Table, Tablecloth and
Overlay

240cm x 150cm Square Dining Table

240cm x 150cm Square Dining Table and Tablecloth
240cm x 150cm Square Dining Table, Tablecloth and

Overlay
Tables—>Metric > 120cm x 120cm Square Dining Table w/ 4 Chairs
Dining—>Square>w/
Chairs

120cm x 120cm Square Dining Table w/ 4 Chairs and
Tablecloth

120cm x 120cm Square Dining Table w/ 4 Chairs,
Tablecloth and Overlay

120cm x 120cm Square Dining Table w/ 4 Chairs,
Tablecloth and Place Settings

150cm x 150cm Square Dining Table w/ 6 Chairs
150cm x 150cm Square Dining Table w/ 6 Chairs and
Tablecloth

150cm x 150cm Square Dining Table w/ 6 Chairs,
Tablecloth and Overlay

150cm x 150cm Square Dining Table w/ 6 Chairs,
Tablecloth and Place Settings

168cm x 168cm Square Dining Table w/ 8 Chairs
168cm x 168cm Square Dining Table w/ 8 Chairs and
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Tablecloth

168cm x 168cm Square Dining Table w/ 8 Chairs,
Tablecloth and Overlay

168cm x 168cm Square Dining Table w/ 8 Chairs,
Tablecloth and Place Settings

180cm x 180cm Square Dining Table w/ 8 Chairs 1
180cm x 180cm Square Dining Table w/ 8 Chairs and
Tablecloth 1

180cm x 180cm Square Dining Table w/ 8 Chairs,
Tablecloth and Overlay 1

180cm x 180cm Square Dining Table w/ 8 Chairs,
Tablecloth and Place Settings 1

180cm x 180cm Square Dining Table w/ 8 Chairs 2
180cm x 180cm Square Dining Table w/ 8 Chairs and
Tablecloth 2

180cm x 180cm Square Dining Table w/ 8 Chairs,
Tablecloth and Overlay 2

180cm x 180cm Square Dining Table w/ 8 Chairs,
Tablecloth and Place Settings 2

180cm x 150cm Square Dining Table w/ 8 Chairs
180cm x 150cm Square Dining Table w/ 8 Chairs and
Tablecloth

180cm x 150cm Square Dining Table w/ 8 Chairs,
Tablecloth and Overlay

180cm x 150cm Square Dining Table w/ 8 Chairs,
Tablecloth and Place Settings

240cm x 150cm Square Dining Table w/ 8 Chairs
240cm x 150cm Square Dining Table w/ 8 Chairs and
Tablecloth

240cm x 150cm Square Dining Table w/ 8 Chairs,
Tablecloth and Overlay

240cm x 150cm Square Dining Table w/ 8 Chairs,
Tablecloth and Place Settings

240cm x 150cm Square Dining Table w/ 10 Chairs
240cm x 150cm Square Dining Table w/ 10 Chairs and
Tablecloth

240cm x 150cm Square Dining Table w/ 10 Chairs,
Tablecloth and Overlay

240cm x 150cm Square Dining Table w/ 10 Chairs,
Tablecloth and Place Settings

Table>Metric> 90 Folding Table 90cm Round w/ 4 Folding Chairs
Dining>Round cm
Folding w/

Folding Chairs

Folding Table 90cm Round w/ 4 Folding Chairs and
Tablecloth

Folding Table 90cm Round w/ 4 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 90cm Round w/ 4 Folding Chairs, Tablecloth
and Overlay
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Folding Table 90cm Round w/ 4 Folding Chairs, Tablecloth
and Place Settings

Folding Table 90cm Round w/ 6 Folding Chairs

Folding Table 90cm Round w/ 6 Folding Chairs and
Tablecloth

Folding Table 90cm Round w/ 6 Folding Chairs, Tablecloth
and Double Overlay

Folding Table 90cm Round w/ 6 Folding Chairs, Tablecloth
and Overlay

Folding Table 90cm Round w/ 6 Folding Chairs, Tablecloth
and Place Settings

120
cm

Folding Table 120cm Round w/ 4 Folding Chairs

Folding Table 120cm Round w/ 4 Folding Chairs and
Tablecloth

Folding Table 120cm Round w/ 4 Folding Chairs,
Tablecloth and Double Overlay

Folding Table 120cm Round w/ 4 Folding Chairs,
Tablecloth and Overlay

Folding Table 120cm Round w/ 4 Folding Chairs,
Tablecloth and Place Settings

Folding Table 120cm Round w/ 6 Folding Chairs

Folding Table 120cm Round w/ 6 Folding Chairs and
Tablecloth

Folding Table 120cm Round w/ 6 Folding Chairs,
Tablecloth and Double Overlay

Folding Table 120cm Round w/ 6 Folding Chairs,
Tablecloth and Overlay

Folding Table 120cm Round w/ 6 Folding Chairs,
Tablecloth and Place Settings

Folding Table 120cm Round w/ 8 Folding Chairs

Folding Table 120cm Round w/ 8 Folding Chairs and
Tablecloth

Folding Table 120cm Round w/ 8 Folding Chairs,
Tablecloth and Double Overlay

Folding Table 120cm Round w/ 8 Folding Chairs,
Tablecloth and Overlay

Folding Table 120cm Round w/ 8 Folding Chairs,
Tablecloth and Place Settings

150
cm

Folding Table 150cm Round w/ 4 Folding Chairs

Folding Table 150cm Round w/ 4 Folding Chairs and
Tablecloth

Folding Table 150cm Round w/ 4 Folding Chairs,
Tablecloth and Double Overlay

Folding Table 150cm Round w/ 4 Folding Chairs,
Tablecloth and Overlay

Folding Table 150cm Round w/ 4 Folding Chairs,
Tablecloth and Place Settings

Folding Table 150cm Round w/ 6 Folding Chairs
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Folding Table 150cm Round w/ 6 Folding Chairs and
Tablecloth

Folding Table 150cm Round w/ 6 Folding Chairs,
Tablecloth and Double Overlay

Folding Table 150cm Round w/ 6 Folding Chairs,
Tablecloth and Overlay

Folding Table 150cm Round w/ 6 Folding Chairs,
Tablecloth and Place Settings

Folding Table 150cm Round w/ 8 Folding Chairs
Folding Table 150cm Round w/ 8 Folding Chairs and
Tablecloth

Folding Table 150cm Round w/ 8 Folding Chairs,
Tablecloth and Double Overlay

Folding Table 150cm Round w/ 8 Folding Chairs,
Tablecloth and Overlay

Folding Table 150cm Round w/ 8 Folding Chairs,
Tablecloth and Place Settings

Folding Table 150cm Round w/ 10 Folding Chairs
Folding Table 150cm Round w/ 10 Folding Chairs and
Tablecloth

Folding Table 150cm Round w/ 10 Folding Chairs,
Tablecloth and Double Overlay

Folding Table 150cm Round w/ 10 Folding Chairs,
Tablecloth and Overlay

Folding Table 150cm Round w/ 10 Folding Chairs,
Tablecloth and Place Settings

168 | Folding Table 168cm Round w/ 6 Folding Chairs

cm

Folding Table 168cm Round w/ 6 Folding Chairs and
Tablecloth

Folding Table 168cm Round w/ 6 Folding Chairs,
Tablecloth and Double Overlay

Folding Table 168cm Round w/ 6 Folding Chairs,
Tablecloth and Overlay

Folding Table 168cm Round w/ 6 Folding Chairs,
Tablecloth and Place Settings

Folding Table 168cm Round w/ 8 Folding Chairs
Folding Table 168cm Round w/ 8 Folding Chairs and
Tablecloth

Folding Table 168cm Round w/ 8 Folding Chairs,
Tablecloth and Double Overlay

Folding Table 168cm Round w/ 8 Folding Chairs,
Tablecloth and Overlay

Folding Table 168cm Round w/ 8 Folding Chairs,
Tablecloth and Place Settings

Folding Table 168cm Round w/ 10 Folding Chairs
Folding Table 168cm Round w/ 10 Folding Chairs and
Tablecloth

Folding Table 168cm Round w/ 10 Folding Chairs,
Tablecloth and Double Overlay
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Folding Table 168cm Round w/ 10 Folding Chairs,
Tablecloth and Overlay

Folding Table 168cm Round w/ 10 Folding Chairs,
Tablecloth and Place Settings

180 | Folding Table 180cm Round w/ 8 Folding Chairs
cm

Folding Table 180cm Round w/ 8 Folding Chairs and
Tablecloth

Folding Table 180cm Round w/ 8 Folding Chairs,
Tablecloth and Double Overlay

Folding Table 180cm Round w/ 8 Folding Chairs,
Tablecloth and Overlay

Folding Table 180cm Round w/ 8 Folding Chairs,
Tablecloth and Place Settings

Folding Table 180cm Round w/ 10 Folding Chairs
Folding Table 180cm Round w/ 10 Folding Chairs and
Tablecloth

Folding Table 180cm Round w/ 10 Folding Chairs,
Tablecloth and Double Overlay

Folding Table 180cm Round w/ 10 Folding Chairs,
Tablecloth and Overlay

Folding Table 180cm Round w/ 10 Folding Chairs,
Tablecloth and Place Settings

Folding Table 180cm Round w/ 12 Folding Chairs
Folding Table 180cm Round w/ 12 Folding Chairs and
Tablecloth

Folding Table 180cm Round w/ 12 Folding Chairs,
Tablecloth and Double Overlay

Folding Table 180cm Round w/ 10 Folding Chairs,
Tablecloth and Overlay

Folding Table 180cm Round w/ 10 Folding Chairs,
Tablecloth and Place Settings

Tables > Imperial 24"x42" Restaurant Table
—~>Restaurant
—>Rectangular

24"x42" Restaurant Table with Place Settings

24"x42" Restaurant Table with Tablecloth

24"x42" Restaurant Table with Tablecloth and Overlay
24"x42" Restaurant Table with Tablecloth, Overlay and
Place Settings

24"x42" Restaurant Table with Tablecloth and Place
Settings

30"x42" Restaurant Table

30"x42" Restaurant Table with Place Settings

30"x42" Restaurant Table with Tablecloth

30"x42" Restaurant Table with Tablecloth and Overlay
30"x42" Restaurant Table with Tablecloth, Overlay and
Place Settings

30"x42" Restaurant Table with Tablecloth and Place
Settings
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30"x72" Restaurant Table

30"x72" Restaurant Table with Place Settings

30"x72" Restaurant Table with Tablecloth

30"x72" Restaurant Table with Tablecloth and Overlay
30"x72" Restaurant Table with Tablecloth, Overlay and
Place Settings

30"x72" Restaurant Table with Tablecloth and Place
Settings

Tables 2> Imperial 24"x42" Restaurant Table with 4 Chairs
—>Restaurant
->Rectangular w/ Chairs

24"x42" Restaurant Table with Place Settings and 4 Chairs
24"x42" Restaurant Table with Tablecloth and 4 Chairs
24"x42" Restaurant Table with Tablecloth, Overlay and 4
Chairs

24"x42" Restaurant Table with Tablecloth, Overlay, Place
Settings and 4 Chairs

24"x42" Restaurant Table with Tablecloth, Place Settings
and 4 Chairs

30"x42" Restaurant Table with 4 Chairs

30"x42" Restaurant Table with Place Settings and 4 Chairs
30"x42" Restaurant Table with Tablecloth and 4 Chairs
30"x42" Restaurant Table with Tablecloth, Overlay and 4
Chairs

30"x42" Restaurant Table with Tablecloth, Overlay, Place
Settings and 4 Chairs

30"x42" Restaurant Table with Tablecloth, Place Settings
and 4 Chairs

30"x72" Restaurant Table with 6 Chairs

30"x72" Restaurant Table with Place Settings and 6 Chairs
30"x72" Restaurant Table with Tablecloth and 6 Chairs
30"x72" Restaurant Table with Tablecloth, Overlay and 6
Chairs

30"x72" Restaurant Table with Tablecloth, Overlay, Place
Settings and 6 Chairs

30"x72" Restaurant Table with Tablecloth, Place Settings
and 6 Chairs

Tables > Metric 61cm x 107cm Restaurant Table
2> Restaurant
—>Rectangular

61cm x 107cm Restaurant Table with Place Settings

61cm x 107cm Restaurant Table with Tablecloth

61cm x 107cm Restaurant Table with Tablecloth and
Overlay

61cm x 107cm Restaurant Table with Tablecloth, Overlay
and Place Settings

61cm x 107cm Restaurant Table with Tablecloth and Place
Settings

76cm x 107cm Restaurant Table

76cm x 107cm Restaurant Table with Place Settings
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76cm x 107cm Restaurant Table with Tablecloth

76cm x 107cm Restaurant Table with Tablecloth and
Overlay

76cm x 107cm Restaurant Table with Tablecloth, Overlay
and Place Settings

76cm x 107cm Restaurant Table with Tablecloth and Place
Settings

76cm x 183cm Restaurant Table

76cm x 183cm Restaurant Table with Place Settings

76cm x 183cm Restaurant Table with Tablecloth

76cm x 183cm Restaurant Table with Tablecloth and
Overlay

76cm x 183cm Restaurant Table with Tablecloth, Overlay
and Place Settings

76cm x 183cm Restaurant Table with Tablecloth and Place
Settings

Tables > Metric
2> Restaurant
->Rectangular w/ Chairs

61cm x 107cm Restaurant Table with 4 Chairs

61cm x 107cm Restaurant Table with Place Settings and 4
Chairs

61cm x 107cm Restaurant Table with Tablecloth and 4
Chairs

61cm x 107cm Restaurant Table with Tablecloth, Overlay
and 4 Chairs

61cm x 107cm Restaurant Table with Tablecloth, Overlay,
Place Settings and 4 Chairs

61cm x 107cm Restaurant Table with Tablecloth, Place
Settings and 4 Chairs

76cm x 107cm Restaurant Table with 4 Chairs

76cm x 107cm Restaurant Table with Place Settings and 4
Chairs

76cm x 107cm Restaurant Table with Tablecloth and 4
Chairs

76cm x 107cm Restaurant Table with Tablecloth, Overlay
and 4 Chairs

76cm x 107cm Restaurant Table with Tablecloth, Overlay,
Place Settings and 4 Chairs

76cm x 107cm Restaurant Table with Tablecloth, Place
Settings and 4 Chairs

76cm x 183cm Restaurant Table with 6 Chairs

76cm x 183cm Restaurant Table with Place Settings and 6
Chairs

76cm x 183cm Restaurant Table with Tablecloth and 6
Chairs

76cm x 183cm Restaurant Table with Tablecloth, Overlay
and 6 Chairs

76cm x 183cm Restaurant Table with Tablecloth, Overlay,
Place Settings and 6 Chairs

76cm x 183cm Restaurant Table with Tablecloth, Place
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Settings and 6 Chairs

Tables > Imperial
—~>Restaurant »>Square

24"x24" Restaurant Table

24"x24" Restaurant Table with Place Settings

24"x24" Restaurant Table with Tablecloth

24"x24" Restaurant Table with Tablecloth and Overlay

24"x24" Restaurant Table with Tablecloth, Overlay and
Place Settings

24"x24" Restaurant Table with Tablecloth and Place
Settings

30"x30" Restaurant Table

30"x30" Restaurant Table with Place Settings

30"x30" Restaurant Table with Tablecloth

30"x30" Restaurant Table with Tablecloth and Overlay

30"x30" Restaurant Table with Tablecloth, Overlay and
Place Settings

30"x30" Restaurant Table with Tablecloth and Place
Settings

36"x36" Restaurant Table

36"x36" Restaurant Table with Place Settings

36"x36" Restaurant Table with Tablecloth

36"x36" Restaurant Table with Tablecloth and Overlay

36"x36" Restaurant Table with Tablecloth, Overlay and
Place Settings

36"x36" Restaurant Table with Tablecloth and Place
Settings

Tables—>Imperial->
Restaurant > Square w/
Chairs

24"x24" Restaurant Table with 2 Chairs

24"x24" Restaurant Table with Place Settings and 2 Chairs

24"x24" Restaurant Table with Tablecloth and 2 Chairs

24"x24" Restaurant Table with Tablecloth, Overlay and 2
Chairs

24"x24" Restaurant Table with Tablecloth, Overlay, Place
Settings and 2 Chairs

24"x24" Restaurant Table with Tablecloth, Place Settings
and 2 Chairs

30"x30" Restaurant Table with 4 Chairs

30"x30" Restaurant Table with Place Settings and 4 Chairs

30"x30" Restaurant Table with Tablecloth and 4 Chairs

30"x30" Restaurant Table with Tablecloth, Overlay and 4
Chairs

30"x30" Restaurant Table with Tablecloth, Overlay, Place
Settings and 4 Chairs

30"x30" Restaurant Table with Tablecloth, Place Settings
and 4 Chairs

36"x36" Restaurant Table with 4 Chairs

36"x36" Restaurant Table with Place Settings and 4 Chairs

36"x36" Restaurant Table with Tablecloth and 4 Chairs

36"x36" Restaurant Table with Tablecloth, Overlay and 4
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Chairs

36"x36" Restaurant Table with Tablecloth, Overlay, Place
Settings and 4 Chairs

Tables > Metric
->Restaurant > Square

61cm x 61cm Restaurant Table

61cm x 61cm Restaurant Table with Place Settings

61cm x 61cm Restaurant Table with Tablecloth

61cm x 61cm Restaurant Table with Tablecloth and
Overlay

61cm x 61cm Restaurant Table with Tablecloth, Overlay
and Place Settings

61cm x 61cm Restaurant Table with Tablecloth and Place
Settings

76cm x 76cm Restaurant Table

76cm x 76cm Restaurant Table with Place Settings

76cm x 76cm Restaurant Table with Tablecloth

76cm x 76cm Restaurant Table with Tablecloth and
Overlay

76cm x 76cm Restaurant Table with Tablecloth, Overlay
and Place Settings

76cm x 76cm Restaurant Table with Tablecloth and Place
Settings

91cm x 91cm Restaurant Table

91cm x 91cm Restaurant Table with Place Settings

91cm x 91cm Restaurant Table with Tablecloth

91cm x 91cm Restaurant Table with Tablecloth and
Overlay

91cm x 91cm Restaurant Table with Tablecloth, Overlay
and Place Settings

91cm x 91cm Restaurant Table with Tablecloth and Place
Settings

Tables > Metric
->Restaurant > Square
w/ Chairs

61cm x 61cm Restaurant Table with 2 Chairs

61lcm x 61cm Restaurant Table with Place Settings and 2
Chairs

61cm x 61cm Restaurant Table with Tablecloth and 2
Chairs

61cm x 61cm Restaurant Table with Tablecloth, Overlay
and 2 Chairs

61lcm x 61cm Restaurant Table with Tablecloth, Overlay,
Place Settings and 2 Chairs

61cm x 61cm Restaurant Table with Tablecloth, Place
Settings and 2 Chairs

76cm x 76cm Restaurant Table with 4 Chairs

76cm x 76cm Restaurant Table with Place Settings and 4
Chairs

76cm X 76cm Restaurant Table with Tablecloth and 4
Chairs

76cm x 76cm Restaurant Table with Tablecloth, Overlay
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and 4 Chairs

76cm x 76cm Restaurant Table with Tablecloth, Overlay,
Place Settings and 4 Chairs

76cm x 76cm Restaurant Table with Tablecloth, Place
Settings and 4 Chairs

91cm x 91cm Restaurant Table with 4 Chairs

91cm x 91cm Restaurant Table with Place Settings and 4
Chairs

91cm x 91cm Restaurant Table with Tablecloth and 4
Chairs

91cm x 91cm Restaurant Table with Tablecloth, Overlay
and 4 Chairs

91cm x 91cm Restaurant Table with Tablecloth, Overlay,
Place Settings and 4 Chairs

91cm x 91cm Restaurant Table with Tablecloth, Place
Settings and 4 Chairs

Tables->Imperial Racetrack Shaped Table 36in x 60in
—>Conference
->Racetrack Shaped

Racetrack Shaped Table 36in x 60in w/ Skirt
Racetrack Shaped Table 36in x 72in
Racetrack Shaped Table 36in x 72in w/ Skirt

Chairs Dining Chair 01

Dining Chair 01 w/Cushion

Slat Back Chair

Slat Back Chair w/ Cushion

Designer Banquet Chair

Covered Designer Banquet Chair
Covered Designer Banquet Chair w/ Sash

Chairs > Theatre Seats Theatre Seat w/ Both Arms
Theatre Seat w/ Left Arm
Theatre Seat w/ Right Arm

Objects »>Musical Iltems | Short Music Stand
Tall Music Stand

Office >Equipment Workstation w/ 15in LCD Monitor
—>Imperial/Metric
—>Workstations w/ LCD

Monitors
Workstation w/ 17in LCD Monitor
Workstation w/ 19in LCD Monitor
Workstation w/ 21in LCD Monitor
Office - Imperial 15in Computer LCD Monitor
—>Equipment

17in Computer LCD Monitor
19in Computer LCD Monitor
21in Computer LCD Monitor
Computer Keyboard
Computer Mouse

Computer Tower

Printer
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Objects > Imperial/Metric
—>Trees and Plants

Ficus Plant 6ft

Ficus Plant 8ft

AV —>Lighting

Small PAR Light

Medium PAR Light

Large PAR Light

Theatre PAR Light

Fresnel Light

Cyc Light

Mirror Ball

Traditional Chandelier

AV > Consoles

Lighting Console Small

Lighting Console Medium

Moving Light Console 1

Moving Light Console 2

Banquet - Glassware

720z Pitcher

Tulip Wine Glass

Champagne Flute

Martini Glass

Hi-ball Glass

Tumbler

Shot Glass

Banquet > Buffet

Chafing Dish Rectangular

Chafing Dish Rectangular w/ Roll Top

Objects>Imperial>
Centerpieces

Balloon Centerpiece 1

Balloon Centerpiece 2

Objects > Imperial
—>Décor - Balloons

Balloon

Balloon Bouquet 1

Balloon Bouquet 2

Balloon Bouquet 3

Balloon Bouquet 4

Balloon Bouquet 5

Tables>Imperial>
Banquet

6ft18in Table with 2 Chairs

6ft18in Table with 3 Chairs

6ft Classroom Table with 2 Chairs

6ft Classroom Table with 3 Chairs

8ft18in Table with 2 Chairs

8ft18in Table with 3 Chairs

8ft Classroom Table with 2 Chairs

8ft Classroom Table with 3 Chairs

People—>Position>
Sitting

Business Man Sitting 2

Business Man Sitting 3

Business Man Sitting 4

Business Woman Sitting 2

Business Woman Sitting 3

Business Woman Sitting 4
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Casual Man Sitting 2

Casual Man Sitting 3

Casual Man Sitting 4

Casual Woman Sitting 2

Casual Woman Sitting 3

Casual Woman Sitting 4

Office>Imperial >

Equipment

15in Computer LCD Monitor

17in Computer LCD Monitor

19in Computer LCD Monitor

21in Computer LCD Monitor

Computer Keyboard

Computer Mouse

Computer Tower

Printer

Chairs=> Theatre Seats

Theatre Seat w/ Both Arms

Theatre Seat w/ Left Arm

Theatre Seat w/ Right Arm

Objects> Musical
ltems->Music Stands

Short Music Stand

Tall Music Stand

Buffet Equipment

Tray

Tray Covered

AV-> Format 5ft x 7ft6in Folding Screen
Projection Frame 6ft x 8ft Folding Screen
Screens—> 6ft x 9ft Folding Screen
Folding 7ft6in x 10ft Folding Screen
Screens 7ft x 10ft6in Folding Screen
(without 8ft x 12ft Folding Screen
drape) oft x 12ft Folding Screen

10ft6in x 14ft Folding Screen

54in x 74in Folding Screen

56in x 96in Folding Screen

62in x 108in Folding Screen

63in x 84in Folding Screen

69in x 120in Folding Screen

83in x 144in Folding Screen

Square 7ft x 7ft Folding Screen
Frame 8ft x 8ft Folding Screen

9ft x 9ft Folding Screen

10ft x 10ft Folding Screen

12ft x 12ft Folding Screen

54in x 54in Folding Screen

72in x 72in Folding Screen
AV-> Format 5ft x 7ft6in Folding Screen w/Drape
Projection Frame 6ft x 8ft Folding Screen w/Drape
Screens—> 6ft x 9ft Folding Screen w/Drape
Folding 7ft6in x 10ft Folding Screen w/Drape
Screens

7ft x 10ft6in Folding Screen w/Drape
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(w/ Drape) 8ft x 12ft Folding Screen w/Drape
9ft x 12ft Folding Screen w/Drape
10ft6in x 14ft Folding Screen w/Drape
54in x 74in Folding Screen w/Drape
56in x 96in Folding Screen w/Drape
62in x 108in Folding Screen w/Drape
63in x 84in Folding Screen w/Drape
69in x 120in Folding Screen w/Drape
83in x 144in Folding Screen w/Drape
Square 7ft x 7ft Folding Screen w/Drape
Frame 8ft x 8ft Folding Screen w/Drape
9ft x 9ft Folding Screen w/Drape
10ft x 10ft Folding Screen w/Drape
12ft x 12ft Folding Screen w/Drape
54in x 54in Folding Screen w/Drape
72in x 72in Folding Screen w/Drape
AV-> Format 43in x 57in Tripod Screen
Projection Frame 45in x 60in Tripod Screen
Screens 2> 50in x 67in Tripod Screen
Tripod 60in x 80in Tripod Screen
Screens 69in x 92in Tripod Screen
(without 72in x 96in Tripod Screen
drape) Square 50in x 50in Tripod Screen
Frame 60in x 60in Tripod Screen
70in x 70in Tripod Screen
84in x 84in Tripod Screen
96in x 96in Tripod Screen
AV-> Format 43in x 57in Tripod Screen w/Drape
Projection Frame 45in x 60in Tripod Screen w/Drape
Screens—> 50in x 67in Tripod Screen w/Drape
Tripod 60in x 80in Tripod Screen w/Drape
Screens 69in x 92in Tripod Screen w/Drape
(w/ Drape) 72in x 96in Tripod Screen w/Drape
Square 50in x 50in Tripod Screen w/Drape
Frame 60in x 60in Tripod Screen w/Drape
70in x 70in Tripod Screen w/Drape
84in x 84in Tripod Screen w/Drape
96in x 96in Tripod Screen w/Drape
AV-> Format 50in x 67in Classic Manual
Projection | Frame 60in x 80in Classic Manual
Screens—> 69in x 92in Classic Manual
Classic Square 70in x 70in Classic Manual
Manual Format 80in x 80in Classic Manual
Screens 96in x 96in Classic Manual
AV-> Format 43in x 57in Electric Screen
Projection Frame 50in x 67in Electric Screen
Screens-> 57in X 77in Electric Screen
Electric 60in x 80in Electric Screen
Screens 69in x 92in Electric Screen
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87in x 116in Electric Screen

105in x 140in Electric Screen

120in x 160in Electric Screen

123in x 164in Electric Screen

141in x 188in Electric Screen

92in x 164in Electric Screen

106in x 188in Electric Screen

6ft x 8ft Electric Screen

7ft x 9ft Electric Screen

8ft x 10ft Electric Screen

oft x 12ft Electric Screen

Square
Format

50in x 50in Electric Screen

60in x 60in Electric Screen

70in x 70in Electric Screen

84in x 84in Electric Screen

8ft x 8ft Electric Screen

oft x 9ft Electric Screen

10ft x 10ft Electric Screen

12ft x 12ft Electric Screen

14ft x 14ft Electric Screen

16ft x 16ft Electric Screen

AV-> Projection
Screens—> Fixed Frame
Screens

41in x 56in Fixed Frame Screen

50in x 67in Fixed Frame Screen

59in x 80in Fixed Frame Screen

68in x 92in Fixed Frame Screen

90in x 120in Fixed Frame Screen

108in x 144in Fixed Frame Screen

120in x 160in Fixed Frame Screen

144in x 192in Fixed Frame Screen

Total Library Additions

Library Modifications

Total New Table and Chair Arrangements: 819
Total New Chair Styles: 9

Total New Banquet Items: 9

Total New AV Items: 11

Total New Office Equipment Items: 12

Total New Décor Items: 8

Total New Items Miscellaneous: 6

Total New Obijects: 874

The following items were changed in this release.

Item

Description

Crystal Chandelier

Removed

Business Man Sitting 2

More realistic seating positions

Business Man Sitting 3
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Business Man Sitting 4

Business Woman Sitting 2

Business Woman Sitting 3

Business Woman Sitting 4

Casual Man Sitting 2

Casual Man Sitting 3

Casual Man Sitting 4

Casual Woman Sitting 2

Casual Woman Sitting 3

Casual Woman Sitting 4

More realistic seating positions

Fixes

Bug description: The toolbars are difficult to move, lose their position easily,
and are hard to arrange.

Fix: Toolbars do not lose their positions anymore. They are now easily moved
with the new toolbar library, and can be arranged in the desired positions with
ease. After toolbars are placed in a location, they remain there until they are
moved again.

Bug description: You cannot apply a texture to all sides of an object that has
been 3D transformed.

Fix: Surfaces that are 3D Transformed can now be textured on all sides of the
object.

Bug description: When trying to import a large image as a floorplan, the
program crashes.

Fix: You can now import large images as floorplans. All textures are handled
properly and the program no longer crashes. If you attempt to import an image
with a resolution larger than 2048x2048, the program displays a warning, asking
you to reduce the image resolution before import.

Bug description: After changing some of the options on the Application Options
> File Options and OpenGL tabs, the software did not warn you that a restart was
required for these changes to take effect.

Fix: For some of the options on the Application Options > File Options and
OpenGL tabs, you will now be alerted that the program needs to be restarted
before any changes take effect.

Bug description: When running a dual-monitor configuration, an issue arises
when you move non-docked tools to the second monitor, and then disable the
second monitor. In this case, these un-docked tools are inaccessible until you
reintroduce the second monitor.

Fix: This issue no longer occurs. The undocked tools are now accessible from
the primary monitor even after the second monitor has been disabled.

Bug description: When viewing popup windows of the Virtual View on a
secondary monitor, the resolution is restricted by the size of the primary monitor.
Fix: This issue has been fixed. The secondary monitor is no longer restricted to
the resolution of the primary monitor.
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11.

12.

13.

14.

15.

16.

17.

18.

Bug description: Beams pass through surface combinations that have been
copy/pasted into your Vivien file.

Fix: This issue no longer occurs. Beams no longer pass through these surfaces.
Bug description: When running Vivien on Windows Vista, the program does
not close cleanly.

Fix: This issue no longer occurs. Vivien closes properly when running on the
Windows Vista operating system.

Bug description: When a file with custom textures is saved before viewing the
texture on the Virtual View tab, the custom texture is not actually saved with the
file.

Fix: This issue no longer occurs. The custom texture is now saved with the file
even if you do not view it on the Virtual View tab.

Bug description: Custom textures are not visible when opening a saved file on a
second computer.

Fix: Custom textures are now saved with the file properly. When a custom
texture is applied to a surface or screen, or saved as part of a custom library
object, it will be displayed when the file is opened on another computer.

Bug description: When you draw a seating area, and then click one of its
vertices to resize it, the light emission and Use Layer Properties settings would
disappear.

Fix: This issue no longer occurs. These settings remain intact when you resize
the seating area.

Bug description: When drawing a non-rectangular seating area, the remove
last step feature is not available.

Fix: This feature is now available in this scenario.

Bug description: The minimum length of the Pipe truss type is too long for files
that require small pipes.

Fix: The minimum length of the pipe (in the Truss Wizard) has been changed to
6" (or 0.2m). For all other truss types, the minimum length is still 2' or 0.5m.

Bug description: The Truss Wizard does not “remember” the last values
entered.

Fix: The Truss Wizards now remembers the last values you entered, making it
easier to draw custom lengths of truss.

Bug description: When you clone a grid, the new objects are inserted on the
XY plane in Isometric view, regardless of the workplane selected.

Fix: This issue has been fixed. The clone is now inserted in any of the three
planes, XY, XZ, YZ, depending on which one is selected.

Bug description: The Truss Wizard does not convert between unit types and
the Imperial defaults are not consistent. Now, switching between metric and
imperial will give you the equivalent measurement in the other unit type.

Fix: This issue has been fixed. You can now switch between Metric and Imperial
and see the equivalent measurement in the other unit type.

Bug description: When a file with a user-defined origin is merged into another
file, the file is merged in with the default origin and not the user-defined origin.
Fix: This issue has been fixed. Now the file is merged in with the new origin
defined by the user and saved in the file.

Bug description: The Render Wizard does not oblige you to select an external
location to save your rendered image when a browse window is opened, but
instead lets you continue through the steps of the Render Wizard without
selecting a destination.

Fix: This issue is now fixed. A new Save As window appears which must be
closed before you can continue with the Render Wizard.
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19. Bug description: The status bar does not display the X, Y, and Z coordinates in
a user-friendly manner.

Fix: The status bar has now isolated the values of the X coordinate, Y
coordinate, and Z coordinate to align them in a way that makes it easier for the
user to read the cursor location.

20. Bug description: Popup windows in drawing views (Drawing Wireframe and
Drawing Quad) do not retain the View Option properties of the parent view from
which they are opened.

Fix: Popup windows now retain the View Option properties of the parent view
from which they were opened. For example, if the view type of the parent view is
the 3D view and the properties have been changed so that the background color,
grid style, and grid scale are different than their defaults, the popup window will
also retain that information.

21. Bug description: When aligning arcs, the alignment feature treats them as full
circles in the calculations.

Fix: This issue has now been fixed. Arcs can now be aligned correctly.

22. Bug description: When applying images onto screens, the screen would take
the color of the layer it was on by default, sometimes resulting in the image not
displaying very well (or looking washed out).

Fix: This is now resolved. The screen no longer takes on the layer color by
default, but instead adopts the color black, which is best for displaying images.

23. Bug description: Elements of custom library items that comprise lines are not
rendered.

Fix: This issue has now been fixed. You can now create custom library items
containing lines (for example custom lengths of truss) and render them properly.

Workarounds

Vivien 2.0 includes the following workarounds for known issues:

Issue: When you click the Layouts tab, create and attempt to save a new Layout, Vivien
crashes.
Workaround: This issue results from a conflict between the Layouts tab and the default
printer configured on your computer. As a workaround, you have three options:
« If you have an alternate printer that doesn't cause a crash, set it to be the default.
« If you have Microsoft Office installed, you will have a virtual printer called
Microsoft Office Document Imaging Writer. Set this printer to be the default. After
doing so, you can print your spreadsheets/layouts/reports/etc. to this virtual
printer, and then use the Microsoft Office Document Imaging program (Start-
>Programs->Microsoft Office->Microsoft Office Tools) to print the file to your real
printer.
« You can install and use an alternate virtual printer, such as Adobe Acrobat
Distiller or PDFCreator.

Issue: When you try to install Vivien, you receive an error message preceded with one
of the following numbers: -5003, -5009, -6001, -6002, or -6009.
Workaround: These messages appear when your computer contains a version of the
InstallShield software that is out of date. To rectify the issue, you must rename the
InstallShield folder so it is not referenced, and then launch the Vivien install file again.
1. Navigate to the folder C:\Program Files\Common
Files\InstallShield\Professional\RunTime\0701.
2. Highlight the 0701 folder, right-click, and select Rename.
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3. Alter the name of the folder. For example, you could type old_0701, and then
press Enter. The folder is now renamed old_0701.

4. Double-click the Vivien install file to run the installation again. If the installation is
still unsuccessful, proceed with the following steps to rename the parent
directory.

5. Navigate to the folder C:\Program Files\Common Files\InstallShield.

6. Highlight the InstallShield folder, right-click, and select Rename.

7. Alter the name of the folder. For example, you could type old_InstallShield, and
then press Enter. The folder is now renamed old_InstallShield.

8. Double-click the Vivien install file to run the installation again.

Known Issues
Cannot Copy, Paste, Array, or Move selected objects that include a lighting object

The Copy, Paste, Array, and Move commands do not work on a selected group of
objects that includes a lighting object. You can perform these commands on individually
selected lighting objects or groups of selected objects that do not contain a lighting
object.

Cannot Cut, Copy, or Paste items in the Layouts tab

Copy, Cut, and Paste commands are not available on the Edit menu or toolbar in the
Layouts tab.

Cannot Undo, Redo, or Repeat last command in the Spreadsheet tab

Undo, Redo, and Repeat commands are not available on the Edit menu or by shortcut
keys in the Spreadsheet tab.

Contacting Technical Support
Read the online documentation and visit the www.viviendesign.com web site before
contacting Technical Support. Contact Technical Support at the following location:

CAST Software

Technical Support

35 Ripley Avenue, Unit 1

Toronto, ON M6S 3P2

Canada

Toll Free Tel: +1.877.989.2278
Fax: +1.416.597.9594

Email: techsupport@cast-soft.com
Web site: www.viviendesign.com

Copyright Information

© The CAST Group of Companies Inc. 2004-2008. All rights reserved.
35 Ripley Avenue, Unit 1

Toronto, Ontario

Canada M6S 3P2

"Vivien” and “CAST Software” are trademarks of the CAST Group of Companies Inc.
Other brands or products are the trademarks or registered trademarks of their respective
holders and should be treated as such.
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